Chapter No. 2
"Mini Mug"
In this package, you will find:
A Biography of the author of the book
A preview chapter from the book, Chapter NO.2 "Mini Mug"
A synopsis of the book’s content
Information on where to buy this book

About the Author

Joe Larson is one part artist, one part mathematician, one part teacher, and one part technologist. It all started in his youth on a Commodore 64 doing BASIC programming and low resolution digital art. As technology progressed, so did Joe’s dabbling eventually taking him to 3D modeling while in high school and college, momentarily pursuing a degree in Computer Animation. He abandoned the track for the much more sensible goal of becoming a Math teacher, which he accomplished when he taught 7th grade Math in Colorado. He now works as an application programmer.

When Joe first heard about 3D printing, it took root in his mind and he went back to dust off his 3D modeling skills. In 2012, he won a Makerbot Replicator 3D printer in the Tinkercad/Makerbot Chess challenge with a chess set that assembles into a robot. Since then his designs on Thingiverse, have been featured on Thingiverse, Gizmodo, Shapeways, Makezine, and others. He currently maintains the blog joesmakerbot.blogspot.com, documenting his adventures in 3D printing.

Dedicated to my wife, who I’ve seen far too little of during the process of making this book.

Thanks to the people at Packt Publishing who reached out to help me write this book.

Special thanks to the awesome people at Makerbot.

For More Information:
3D Printing Blueprints

A new industrial age is here. Machines designed to build useful and interesting objects have moved from the factory to the home. But these 3D printers can't make things without a design. Whether you have a 3D printer or not, designing things for 3D printers to make is the best way to become a part of the 3D printing movement. Learn to design successful models for home by 3D printing on a Makerbot or other 3D printer with cool hands-on lessons.

If you've ever won a round of Pictionary you've got all the artistic skill it takes to get started. If you've ever gotten past level 1 on Tetris then you've got spatial reasoning. If you've ever played with modeling clay then you know all about designing in three dimensions. You can learn and practice the rules of design that will take your virtual models to real life prints you can hold in your hands as well as enable your creations to stand out on popular websites such as Thingiverse.

This book uses blueprints; simple, fun projects that teach Blender modeling for 3D printing in hands-on lessons. First you'll learn basic modeling and make a small simple object. Then each new project brings with it new tools and techniques as well as teaching the rules of 3D printing design. Eventually you'll be building objects designed to repair or replace everyday objects. Finally, you'll be able to even tackle other people's models and fix them to be 3D printable.

What This Book Covers

Chapter 1, Design Tools and Basics, will start with the rules of designing objects for successful 3D prints and then introduce the software that will be used.

Chapter 2, Mini Mug, introduces the most common modeling tools to make a simple object.

Chapter 3, Face Illusion Vase, uses a reference image, a picture, to help create the shape of a 3D object.

Chapter 4, SD Card Holder Ring, takes measurement of real-life objects and translates them to the design space. Success is measured by how closely the print matches the real life object.

Chapter 5, Modular Robot Toy, combines separate parts with joints to make a single object.

Chapter 6, D6 Spinner, uses the add-on functionality to allow Blender to create new objects and using that to model a new way to choose a number from 1 to 6.

Chapter 7, Teddy Bear Figurine, introduces a different method of modeling that can be used to make appealing organic shapes.

For More Information:
Chapter 8, *Repairing Bad Models*, is a good skill to have when working with other's 3D models, particularly those that might not have been made for 3D printing.

Chapter 9, *Stretchy Bracelet*, shows how advanced 3D printing options can change the way a model is printed.

Chapter 10, *Measuring – Tips and Tricks*, are important to know when translating real life into the design space.
Blender has a variety of exciting tools for 3D modeling. This chapter will cover navigating the file system, adding objects, adjusting the view, selection tools, modification operators, object modifiers, and exporting an object ready for print. With so many things to learn on such a simple first project, by the time you finish you'll want to toast your success. So why not create something for that very purpose?

Our mug will be a miniature one, almost thimble-sized: 24 mm wide by 20 mm tall with a wall thickness of at least 2 mm. We'll put a handle on our mini mug to give it some character and give you something to hold on to. We'll also give it a little bit of body shape to make it more stable and printable. Beside from these we'll take advantage of its size to keep the details to a minimum.

For More Information:
Getting started

Blender opens with a default scene that contains a cube, a light, and a camera, none of which are necessary for this project. So to begin, the virtual work area will need to be cleared and a new file will be created for this project. Saving early is a good idea to name the project area. Saving often is a good idea in case anything bad happens; there is always a risk with any computer project. Saving incrementally is a good idea as a kind of back-up undo memory. And as this is the first project, a basic directory for the projects to follow will be set up. Carry out the following steps to create a new file in Blender:

1. Open Blender.
2. In the menu at the bottom of the 3D View panel choose Select | (De)Select All or press A to toggle the selection. As the cube was selected before this, the toggle will switch it so nothing is selected.
3. Choose Select | (De)Select All or press A again to select everything in the default scene.
4. Choose Object | Delete or press X to start the delete operation.
5. Click on Delete or press Enter to confirm the operation.

6. On the top menu click on File and choose Save As...
7. On the left-hand side bar under System Bookmarks click on Documents.
8. On to top, click on the Create New Directory button and click on Create New Directory in the menu that pops up.
9. Type in MakerbotBlueprints as the name for the new directory.

![Create New Directory](image)

10. Click on the MakerbotBlueprints directory.
11. Click on the Create New Directory button and click again on the menu that comes up.
12. Type in Ch 2 MiniMug as the name for this directory.
13. Click on the Ch 2 MiniMug directory.
14. Click on the untitled.blend in the name bar and type in Mini Mug as the name of the project.
15. Click on the Save As Blender File button.

Creating the first shape
With this project's file created it's time to begin creating the mug. The mug will be made up of two different shapes, so the first thing to do is to add the shapes we need into the scene:

1. In the Info panel (top menu) click on Add or press Shift + A to add a new shape.
2. Mouse over Mesh.
3. Select **Cylinder** from the sub-menu that comes up.

Whenever you add something you have a chance to edit its options. Once these options are gone, you can't go back and change them. The new object is now just a collection of points, same as any other object to Blender so edit those options while you can.

4. On the left-hand sidebar under the Add **Cylinder** option, click on the number in **Vertices** and change that number to 8.

5. Press **Tab** to advance to the next option, **Radius**. The mug is designed to be 24 mm wide, so enter a radius of 12 and press **Enter**.

6. Press **Tab** to advance to **Depth**. Enter a depth of 20.

7. Choose **File | Save** or with the pointer over the 3D View panel press **Ctrl + S** and press **Enter** to save.

For More Information:

It is good practice to name the objects to avoid a bunch of nondescript objects such as "Cylinders" and "Cubes" in scenes. To name an object use the Object menu on the right-hand side bar and carry out the following steps:

1. On the right-hand side bar click on the icon that looks like an orange cube to switch to the Object tab.

2. Click on the word Cylinder in the text box to select it.
3. Erase the word Cylinder and type Mug Body followed by Enter to name the object.
4. Select File | Save or with the pointer over the 3D View panel press Ctrl + S and then press Enter to save.

At this point the 3D view will turn into a field of gray. This is expected and will be addressed later after creating a save point.

Creating a save point

Incremental saves are when a new save file is created; leaving the old one in the state it was in. This serves as a sort of extended undo if anything goes wrong. In the case of following a tutorial like this these incremental saves can provide a way back if the reader ever goes astray and doesn't realize it at first, as opposed to having to start all over, avoiding frustration.
Blender contains a powerful shortcut to make incremental saving easy. Carry out the following steps for incremental saving:

1. Select **File | Save As...** or press F2.
2. With the pointer over the file list press + on the number pad to add a number to the file name.
3. Click on **Save As Blender File** to create the new file.

The next time this set of actions are followed the number in the file name will be incremented by 1 automatically.

### Adjusting the view

In the main view there should be nothing but a gray field. This is because the mug is bigger than the current view so now is a good time to list the many ways to change the view in Blender.

- **Rotate the view:** Use the 8, 2, 4, and 6 keys on the number pad to rotate the view. Use the 7, 1, and 3 keys on the number pad to jump to the top, front, and right-hand side views. Use Ctrl + Num pad 7, Ctrl + Num pad 1, and Ctrl + Num pad 3 to jump to the bottom, back, or left-hand side view. Pressing 5 on the number pad toggles orthographic/perspective view which means the view is either rendered with perspective like in real life or without like on a grid that is usually easier to do editing in. These options are also available in the **View** menu at the bottom of the 3D View panel. Click-and-hold the middle mouse button (or your mouse wheel) and move the mouse to rotate the view.

- **Zoom the view:** Use Num pad + and Num pad −, Ctrl + and Ctrl −, or spin the mouse scroll wheel to zoom in and out. Automatically center the view and zoom on all objects by pressing *Shift + C*. This also resets the 3D cursor to the origin. Center the view and zoom on the selected objects by pressing the . (period) key on the number pad.

- **Pan the view:** *Shift + click-and-hold* the middle mouse button to pan the view, or in other words, to move the view without changing the direction you're looking at the scene. Alternately you can press *Shift + F* to begin the "Fly Camera" operation. In Fly Camera move the mouse pointer towards the edge of the screen to turn the camera. The mouse wheel or + and − on the number pad will let you move forward or backwards. *Left-click* or press *Enter* to exit the Fly Camera operation and leave your view where it is at the end. *Right-click* or press *Esc* to cancel the Fly Camera operation and return to where you started.

---

**For More Information:**

Using the view commands adjust the view. In future projects, there will be less emphasis on the specific keys to press to change the view, but for now the steps to carry out are as follows:

1. In the menu at the bottom of the 3D View panel choose **View | Align View | Center Cursor and View All** or press **Shift + C** to center the view on the cylinder.
2. Select **View | Front** or press **Numpad 1** to switch to front view.
3. Select **View | Orthographic or Perspective** or press **Numpad 5** to switch between them.
4. In the bar at the bottom of the 3D View panel click on the combo box with an icon like a white ball and choose the **Wireframe** option or press **Z** to switch to wireframe view.

In **Wireframe** view the object is presented as though it were just made of wire. All edges, even hidden ones, become visible.

For More Information:
Adding a handle
Do an incremental save (Press F2, Numpad +, and then click on Save As Blender File).

Whenever a new object is added, it will appear wherever the 3D cursor is. If the 3D cursor has accidentally moved by a stray, left-click is good to center the view and reset the 3D cursor to the origin by pressing Shift + C before adding a new object.

Carry out the following steps to create a new cube:

1. Select Add in the Info panel menu or press Shift + A and select Mesh | Cube in the menu.

2. Click on the Object tab in the right-hand sidebar and rename this Cube to Handle.

For More Information:
The newly created cube is being seen from the front orthographic view so it looks like a box, but it does have depth. Rotate the view to confirm this. The cylinder is also entirely inside the mug body but it is visible because of wireframe mode. Press Z to toggle back to solid view and the cube will be hidden by the body. Remember to undo any view changes by pressing NumPad 1 or choosing View | Front and toggling to Wireframe mode (Z) before continuing. The steps for the grab operation are as follows:

1. From the menu at the bottom of the 3D View panel choose Object | Transform | Grab/Move or move the mouse pointer over the handle cube and press G to begin the grab operation.
2. Move the mouse until the handle is inside the lower-right corner of the mug body.
3. Press Enter or left-click to end the grab operation.
4. Press Ctrl + S and Enter to save.

Object manipulation such as movement, rotation, or scaling are all done by default relative to the current view. As the current view is the front view, the grab operation will only move up and down or left and right, or along the x and z axes.

Carry out the following steps for the rotate operation:

1. Choose Object | Transform | Rotate or press R to begin the rotation operation.
2. Type in 45 to rotate the handle.

For More Information:
3. Press Enter or left-click to end the rotate operation.
4. Press Ctrl + S and Enter to save.

Shaping the handle
Pan and zoom the view as explained before to adjust the view to focus on the right half of the mug with plenty of space to make the handle in.

For More Information:
Blender allows direct manipulation of the individual points or vertices that make up an object in **Edit Mode**. Many things that you can do in terms of selection and manipulation work similarly in and out of **Edit Mode**.

1. On the menu at the bottom of the 3D View panel click on the combo box with the option for **Object Mode** visible and select **Edit Mode** or press Tab to enter **Edit Mode**.
2. Choose **Select** | (De)select all or press A so that no points are selected.
3. Choose **Select** | **Circle Select** or press C to begin the circle select operation.
4. Scroll the mouse wheel to adjust the circle select tool size.
5. Hold left mouse button and to move the selection area to select the vertices shown in the next screenshot.
6. **Right-click** or press **Enter** to end the circle and select operation.

In **Wireframe** mode selecting the vertices one at a time (with the **right-click** on mouse) cannot be done in confidence as the vertex selected may be any of the overlapping vertices, if overlapping vertices there are, as in this case. Using the circle select operation selects them all.

The extrude operation creates a new points based on the selected points and allows you to extend or move these shapes away from where they started. This is a quick and easy way to change the geometry of the shape.

1. Select **Mesh** | **Extrude Region** or press E to begin the extrude operation.
2. Move the mouse to move the extruded selection away from where they started.

For More Information:
3. *Left-click* or press *Enter* to end the extrude operation.

4. Select **Mesh | Transform | Rotate** or press *R* to begin the rotation operation.
5. *Left-click* or press *Enter* to end the rotation operation.
6. Select **Mesh | Transform | Grab/Move** or press *G* to begin the grab operation.
7. Use the mouse to set the location similar to the illustration.
8. *Left-click* or press *Enter* to end the grab operation.
9. Move the mouse to rotate the points similar to the illustration in the following screenshot:

For More Information:
Building the rest of the handle is as easy as; **Extrude (E), Rotate (R), Grab/Move (G)**, repeat. At each stage be sure that the points you created approximately match what you see in the illustration in the following screenshot. Keep it rough at this point. Smoothing out the mesh comes later.

Make sure to remain in front view (*Numpad 1*) when doing the operations or the handle may not remain straight in space. If that occurs remember repeatedly selecting **Mesh | Undo** or pressing *Ctrl + Z* undoes many mistakes. In the worst case reload the last incremental save and back up to that point.
Once the rough shape of the handle is complete, exit **Edit Mode** either by selecting **Object Mode** from the combo box at the bottom of the **3D View** panel, or by pressing the **Tab** key. Then either choose **Solid** from the display combo box or press **Z** to switch to solid view, adjust your view to see how the handle looks in three dimensions.

Before proceeding do another incremental save (press **F2**, then **Numpad +**, and click on **Save As Blender File**).

The handle is in the right shape, but too thin. This is what the scale operator is for. Carry out the following steps for scale operation:

1. With the handle selected, navigate to **Object** | **Transform** | **Scale** or press **S** to begin the scale operation.
2. Move the mouse and you will notice that the whole handle grows bigger and smaller.

---

For More Information:  
3. Press Y to lock the scale to only the y axis.
4. Move the mouse and notice the handle is only scaling in the y axis.
5. Move the mouse until the handle is about three times thicker than it was or type 3. There's no text box to type this into. Simply typing during the operation will define the parameters of the operation in Blender.
6. Press Enter or left-click to end the scale operation.
7. Save (Ctrl + S).
Smoothing the rough edges

Blender provides a number of object modifiers that can be used to quickly alter objects in the scene. In this project only two modifiers, namely Multiresolution and Boolean, will be used. Modifiers can be stacked, turned on and off, and their settings can be changed on the fly. The modifiers are accessed in their own menu in the right-hand side bar.

Begin with an incremental save (Press F2, then Numpad +, and click on Save As Blender File) to set a save point. Then carry out the following steps to create a new modifier:

1. In the right-hand side bar, click on the icon that looks like a wrench to open up the modifier tab.

2. Click on the Add Modifier button.

3. Select from the second column (Generate) the Multiresolution modifier from the menu.

4. In the Multiresolution options box click on the Subdivide button twice.

Multiresolution smoothes the mesh out by adding more vertices between existing vertices and putting them in a location that rounds the shape. In this case the final result looks good except that the top of the handle is too rounded so it doesn't join the body of the mug well. To flatten these curves out more points will need to be added to the original mesh. Fortunately modifiers do not change the original geometry until you click on the Apply button, so you can still modify the shape in Edit Mode.

For More Information:
To further modify the shape carry out the following steps:

1. Enter the **Wireframe** view (Z).
2. Enter **Edit mode** (Tab).
3. The **Loop Cut and Slide** operation is accessed either by finding the button in the left-hand side bar under **Add** or by pressing **Ctrl** + **R**.
4. Move the pointer with the mouse to the lines near the top at the end of the handle, as shown in the next screenshot.
5. **Left-click** to select this subdivision.

For More Information:

6. Move the pointer closer to the end of the handle, to slide the loop cut closer to the end of the handle, but not overlapping the existing points.

7. **Left-click** to end the loop-cut operation.

8. Exit **Edit Mode** (*Tab*).

The top end of the handle is now blunter and will sit inside the mug better. Save the work done so far before continuing further.

## Shaping the body of the mug

Finishing the handle taught many operations and modifiers that will now be applied to the mug body:

1. Begin by setting another save point (Press *F2*, then *Numpad +*, and click on **Save As Blender File**).

2. **Right-click** to select the **mug body** or choose the **mug body** in the Outliner panel.

3. Jump to the front view (*Numpad 1*) and center and zoom (*Numpad .*) on the mug body.

The border select operation is another way to quickly select multiple objects or, in this case, points for editing. Like the circle select tool while in wireframe mode, the border select tool selects all vertices that it surrounds, even if they’re overlapping other points on the screen. The following are the steps for border select operation:

1. Enter **Edit Mode** (*Tab*).

2. Clear the selection (*A*).

3. **Select** | **Border Select** or press *B* to begin the border select operation.

4. Hold left-button on mouse and move the pointer to draw a box around the vertices at the top of the mug body.

---

For More Information:

5. Release the left-button on mouse to end the box select operation.

With the top of the mug body selected, press **Scale (S)** the selected points. Make the top of the mug slightly wider than the bottom. By default the center of the scale operation is relative to the points selected. In this case that works out so the top of the mug widens evenly all around. (This can be a problem for less regular shapes.)

As with most operations, where the mouse is at the start of the scale operation, can affect the outcome. If the mouse pointer is too close to the center, there may not be a high enough degree of control, too close to the edge of the screen and there may not be enough room to move outward. This idea of pointer placement before an operation may take some getting used to but is a powerful reason to use the hot keys because that is not possible with menu select operations. If the pointer placement is ever undesirable simply press **Esc** to cancel the operation and try again.

Do a 1 millimeter extrusion (**E**) of the points at the top of the mug by typing **1** during the extrude operation. The next operation will use extrude in a different way to create points for scaling.

For More Information:

Following are the steps for extrude operation:

1. Do not touch the mouse.
2. Begin the **Extrude** (*E*) operation.
3. Do not move the mouse.
4. Press *Enter* to end the extrude operation.

It is not immediately apparent but the newly extruded points are exactly in the same place as the points they were copied from. Generally having duplicate points like this isn't a good thing, but the new points aren't going to stay where they are.

Pan (Press *Shift* + *middle-click* on mouse) and zoom (using mouse wheel) the view to look closely at one of the upper corners of the mug body. Put the mouse pointer close to the corner of the selected points and **Scale** (*S*) them until they are approximately 2 mm inside the mug body.

By adjusting the view, the result of this operation becomes apparent. This is how the lip of the mug is created.

---

**For More Information:**
Jump back to the **Front** view (*NumPad 1*) and adjust the view to include the whole mug body. **Extrude** (*E*) again, but this time move the extrusion downwards into the mug body until the extrusion is nearly 2 mm, or 2 grid blocks, from the bottom of the mug on the inside. Then save (*Ctrl + S*).
Mini Mug

Zoom (using mouse wheel) and pan (Press Shift + middle-click) to adjust the view to look closely at a lower corner of the mug to fine tune the last extrusion operation.

Carry out the following steps for the grab operation:

1. Begin the Grab/Move (G) operation.
2. Lock movement to the z axis by pressing Z.
3. Move the mouse until the bottom is closer to exactly 2 grid blocks (2 mm) from the bottom.
4. Scale (S) until the bottom of the mug is approximately 2 mm inside the wall of the mug.
5. Save (Ctrl + S).
On a Makerbot it is possible to make things with details as small as 0.4 mm thick because that is the size of the nozzle. However, such small things tend to break easily. Even details as much as 1 mm can be too fragile. The general rule to follow is anything you don't want to break needs to be at least 3 mm thick or more and walls should never be made thinner than 2 mm.

The mug is looking very mug-like now, but it's still very rough and the handle is peeking through the body. First thing to do is in the right-hand side bar switch to the modify tab (the one with the wrench) and hit the Add Modifier to add the MultiResolution modifier to the mug body.

For More Information:
Mini Mug

Click on the **Subdivide** button three times. Now the mug body looks more like a cup, but it doesn't have a stable base for printing. This is an excellent opportunity to give the mug an interesting shape.

Carry out the following steps to give an interesting shape to the mug:

1. Enter **Edit Mode** (Tab).
2. Clear the selection (A).
3. Jump to **Bottom** view (Ctrl + 7).

For More Information:
4. *Right-click* to select one of the vertices on the bottom of the mug.

5. While pressing the *Shift* key, *right-click* on every other vertex on the bottom of the mug body.

6. Move the mouse pointer close to any of the selected points.

7. Begin the *Scale* (*S*) operation.

8. Move the mouse pointer away from the middle until the bottom of the mug body takes on a more-or-less square shape.
9. Press *Enter* to end the scale operation.

If you exit **Edit Mode** at this point the **Multiresolution** modifier will still be making the bottom of the mug too rounded. This is the same as what happened with the handle and is fixed in the same way.
Rotate the view upwards slightly to be able to see the side of the mug. Use the loop cut operator (Ctrl + R) to add extra points around the bottom of the mug near the end. Remember with the loop cut operator the left-selects the edges to be cut, then move the mouse to adjust the location of the cut, then left-click to again set the loop cut.

Exit Edit Mode (Tab) and adjust the view. The mug now has an interesting shape and more importantly a flatter base.
It is time to fix the handle. This is a good time to set a save point (Press F2, then Numpad +, and click on Save As Blender File). Select the handle jump to the front view (Numpad 1) and pan (Shift + middle-click) the view. Enter Edit Mode (Tab) and in Wireframe view (Z) select the points on the top of the handle that are extending too far with either the Border (B) or Circle (C) select tools.

Move the points with the Grab/Move operator (G) until they are inside the wall of the mug and exit Edit Mode to see if the handle stays within the walls of the mug after the modifier is applied. Then save (Ctrl + S).
Joining the shapes

Most of the modeling is done, but this mug is not quite ready to print. The body and handle are still two separate pieces and the bottom of the body, while flatter, isn't quite flat enough to trust to printing. We will be making some changes that will make further editing difficult so first we will make a duplicate of the mug's body easily modifiable objects.

Even though it's only been a while set another save point (Press F2, then Numpad +, and click on Save As Blender File) now.

Carry out the following steps to make a duplicate of the mug:

1. Center the view on all visible objects (Shift + C).
2. Select the mug body (right-click).
3. Do not touch the mouse.
4. **Object** | **Duplicate** or press Shift + D to begin the duplicate operation.
5. If the mouse is moved the duplicate will move which can be useful at times but do not move the mouse this time.
6. Press Enter to end the duplication operation.

With two identical shapes in the same location it can get confusing to select the correct one, so we're going to hide everything but the duplicate object that we're working with. The objects will still be in the scene there, but they'll be invisible and not selectable. In the menu select **Object** | **Show/Hide** | **Hide UnSelected** or press Shift + H to hide all objects but the selected one.
Use the **Object** tab (with the orange cube) to change the name of **Mug Body.001** to **Mug Final**. Remember to save.

The **Mug Final** will be the version that will be prepped for printing. The body of the handle will be merged into this version before some minor edits to the mesh will make it ready to print. To begin, click on the **Mesh** tab in the right-hand side bar (the one with the wrench) and click on **Apply**.

After applying the modifier, if you go to **Edit Mode** you will notice that we can now only modify the high resolution mesh. This is good to do to prepare the mesh for printing but as it cuts off some editing options so it is best to save this step until the end.

---

**For More Information:**
Now a new modifier, **Boolean**, will be used to put the handle on the mug. The two objects will have their geometry combined and any geometry that would be "inside" the final object will be eliminated:

1. Click on the **Add Modifier** button.
2. Select the **Boolean** modifier.

3. In the **Boolean** options click on the button below the word **Operation** which reads **Intersect**.
4. Choose **Union** from the menu that pops up.

5. Click on the box under the word **Object**.
6. Choose **Handle** from the menu that pops up.

---

**For More Information:**
7. Click on the **Apply** button to finalize the **Boolean** modifier.

The handle is now a part of the **Mug Final** object. If you switch to wireframe view (Z) and change your views you will notice the parts of the handle that were inside the mug aren’t there. They are joined so that the whole shape is one continuous shell without hidden vertices inside the shape. This is a best practice for making objects for 3D printing. Remember to save.

**Flattening the bottom**

The bottom of the mug, while flatter than before, is not perfectly flat and is therefore not suitable for printing yet. However, there is a way to use the scale operator in **Edit Mode** to make a flat bottom, by carrying out the following steps:

1. Jump to the front view (**NumPad 1**).
2. Enter **Edit mode** (**Tab**).
3. Clear the selection (**A**).

For More Information:

4. Use the **Box Select** operation \((B)\) to select the bottom few layers.

Without touching the mouse carry out the following steps:

1. Begin the **Scale** \((S)\) operation.
2. Press \(Z\) to lock the scale operation to the z-axis.
3. Type 0 (zero) to scale by a factor of zero.
4. Press *Enter* to end the scale operation.

Rotate the view and notice that all the points that were there before are still there, they are all just on the exact same z level making a perfectly flat bottom for printing.

Remember to save \((Ctrl + S)\).
Exporting for print

All editing of a model done. The mug isn't placed on the platform it's true, it is just kind of floating in space, but it is properly oriented so the 3D printer software will take care of positioning it. All that is left is to export the model in a format that can be sent to the 3D printer.

With the final mug selected (right-click) and when not in Edit Mode (Tab), carry out the following steps:

1. Click on File on the top menu.
2. Click on Export on the menu.
3. In the menu that pops up click on Stl (.stl).

**Standard Tessellation Language (STL)** is a file format that is used to describe the geometry of a shape. It doesn't store much else but the shape which is perfect for 3D printing. Almost every 3D printer can use a STL file.

By default the name of the STL will be the name of the project, which is perfect in this case. Just check to be sure the name is as you like it and click on the Export STL button.

Then open either MakerWare or ReplicatorG, open the STL, and prepare it for printing in the usual way.

For More Information:  
Extra credit

Now that you've learned the basic modeling tools challenge yourself to make your own mug shape, either by modifying the existing model or starting from scratch. Make a mug that is more of a goblet or make a mug with extruded tentacles. Perhaps, something that is more irregular and less symmetrical. The possibilities are endless.

Summary

And that's it. This thimble-sized mug taught a majority of the basic tools that will continue to be used in future 3D modeling projects. Some of those tools are:

- File operations such as saving and creating new directories
- Adding basic objects (Shift + A)
- View rotation with the number pad
- Scene navigation with the middle-button on the mouse
- Wireframe and Solid view modes (Z)
- Selection operations such as Circle (C) and Box (B) select
- Manipulation operations such as Grab/Move (G), Rotate (R), and Scale (S)
- Edit mode (Tab) for manipulation of the individual elements that make up a shape
- The Extrude (E) operation
- The loop-cut (Ctrl + R) operation
- Object modifiers such as Multiresolution and Boolean operations
- Exporting STLs for print

For More Information:
Where to buy this book

You can buy 3D Printing Blueprints from the Packt Publishing website: http://www.packtpub.com/3d-printing-blueprints/book. Free shipping to the US, UK, Europe and selected Asian countries. For more information, please read our shipping policy.

Alternatively, you can buy the book from Amazon, BN.com, Computer Manuals and most internet book retailers.